ULTRABOOK: SYSTEM RESPONSIVENESS,
PERFORMANCE, AND BATTERY LIFE

Thinner. Lighter. Newer.
And...

2 times faster
at launching popular Microsoft® Office applications

52 percent longer
battery life

2.5 times faster
secure hard drive encryption

33 percent smoother
3D gaming performance for Diablo® llI

BEED

Ultrabook™ prototype .....cusmmmime

When you first purchased your laptop, it responded quickly, easily ran the latest
games, and had a long battery life. Now, a few years later, it’s time to replace that
laptop with one that can handle your current demands. With so many options on the
market, how do you choose?

New Ultrabooks inspired by Intel® fit deliver excellent performance and new
Intel technologies in a smaller package so that you can complete all your tasks in a
lighter, more comfortably portable system.

In the Principled Technologies labs, we compared the performance of a pre-
production, 3rd generation Intel Core™ Ultrabook prototype to a 2010 laptop system in
a number of areas, including system responsiveness, battery life, encryption time, and
graphics and gaming performance.

The Ultrabook prototype provided a better experience than the 2010 laptop in
every area: it opened common applications up to twice as quickly, improved battery life
by 52.6 percent, sped up hard drive encryption by 60.2 percent, and improved graphics
performance by up to 174.0 percent.

SEPTEMBER 2012

A PRINCIPLED TECHNOLOGIES TEST REPORT

I Commissioned by Intel Corporation



http://www.principledtechnologies.com/

GET MORE OUT OF LESS

The prototype we tested, like all Ultrabooks, is designed for maximum
portability with a sleek design—it’s less than an inch thick and weighs just over 3
pounds. Using a thinner Intel Core processor with Intel Turbo Boost Technology 2.0 and
solid-state storage, the Ultrabook has the power to handle your everyday tasks, from
Web browsing to media creation and manipulation to gaming. Some Ultrabooks also
have touch-screen technology to further enhance the user experience.

We tested an Ultrabook prototype in a variety of test areas: system
performance, system responsiveness, graphics and gaming performance, general
benchmark performance, battery life, Web browsing performance, and encryption
performance.

If your laptop is more than a couple of years old, updating your system will give
you a significantly better experience today. We compared the performance of an
Ultrabook prototype with an Intel Core i7-3667U processor and Intel HD Graphics 4000
running Microsoft Windows® 8, to that of a commercially available 2010 laptop with an
Intel Core i7-620M processor, NVIDIA® NVS 3100 graphics, 4 GB of memory, and a
7,200-RPM SATA hard drive running Windows 7. For detailed system configuration
information, see Appendix A. For detailed steps on how we tested, see Appendix B.

In every test, the Ultrabook prototype outperformed the 2010 laptop system.
Figure 1 summarizes the most dramatic performance increases the Ultrabook achieved.

Continue reading for an in-depth look at our complete set of test results.

Ultrabook 2010 Percentage

prototype laptop difference
Boot time (secs) 11.90 47.09 74.7%
Hibernate time (sec) 3.60 18.05 80.1%
Launching Microsoft PowerPoint® (secs) 1.28 3.02 57.6%
Graphics - 3DMark® Score 3,280 1,197 174.0%
Performance — PCMark® Score 4,295 1,994 115.4%
Battery Life score (hh:mm) 4:50 3:10 52.6%
Dromaeo JavaScript (runs/sec) 485.13 292.16 66.0%
Time to encrypt the HDD (mm:ss) 20:18 51:03 60.2%

Figure 1: Selected test results for the Ultrabook prototype and 2010 laptop.
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SYSTEM PERFORMANCE

No one likes waiting for a laptop to boot, resume from sleep, or shut down.
Older systems use older technologies, and may not provide the system performance
that a new laptop can provide.

We hand-timed both the Ultrabook prototype and the 2010 laptop booting,
shutting down, sleeping, hibernating, and resuming from hibernate or sleep. In every
instance, the Ultrabook prototype was dramatically faster. It took only 11.9 seconds to
boot while the older laptop took 47 seconds. Figure 2 compares the times, in seconds,

the systems needed to complete these basic, everyday tasks.
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Figure 2: System performance time comparison for the Ultrabook prototype and the 2010 laptop we tested.
Figure 3 details the median results of our system performance tests. The
Ultrabook prototype was quicker than the 2010 laptop in every area we tested,
including hibernating 80.1 percent faster.

Ultrabook prototype 2010 laptop Percentage

(seconds) (seconds) difference
Boot time 11.90 47.09 74.7%
Shutdown time 3.92 9.89 60.4%
Hibernate time 3.60 18.05 80.1%
Resume from hibernate time 9.82 26.98 63.6%
Sleep time 3.34 4.47 25.3%
Resume from sleep time 1.46 3.32 56.0%

Figure 3: Median times, in seconds, for the system performance tests. Lower times are better.
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SYSTEM RESPONSIVENESS

It isn’t only booting and shutting down your laptop that can keep you waiting.
When you open applications multiple times a day, lagging performance can leave you
frustrated.

We tested the responsiveness of both systems launching common applications
including Microsoft Office applications (Word®, Excel®, and PowerPoint®). As in our
system performance tests, the Ultrabook prototype left the 2010 laptop in the dust,
reducing the time to launch applications by as much as 57.6 percent. Figure 4 compares
the application launch times for the two systems.
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Figure 4: Application launch times for the Ultrabook prototype and the 2010 laptop we tested.

As our tests show, moving from your older laptop to a new Ultrabook can also
speed up even more specialized tasks such as photo and video editing. We tested the
responsiveness of the systems when launching photo and video projects and converting
those projects to a different file type in Adobe® Photoshop® Elements and Adobe
Premiere® Elements, and found that the Ultrabook prototype outperformed the 2010
laptop, reducing the time for common tasks by as much as 55.5 percent. Figure 5
compares the time it took the systems to complete common photo and video editing

tasks.
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System responsiveness: Photo and video tasks
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Figure 5: Photo and video editing application task times for the Ultrabook prototype and the 2010 laptop we
tested.

Figure 6 details the median results of our system responsiveness tests. The
Ultrabook prototype was quicker than the 2010 laptop in every area we tested,

including being up to 57.6 percent faster when launching Microsoft PowerPoint.

Ultrabook prototype 2010 laptop Percentage
(mm:ss) (mm:ss) difference

Application launch times
Microsoft Word 00:01.09 00:02.21 50.7%
Microsoft Excel 00:01.10 00:02.34 53.0%
Microsoft PowerPoint 00:01.28 00:03.02 57.6%
Adobe Photoshop Elements tasks
Project launch time 00:09.65 00:21.68 55.5%
Convert project to JPEG 01:34.42 01:48.51 13.0%
Adobe Premiere Elements tasks
Project launch time 00:09.20 00:13.03 29.4%
Convert project to MPEG-2 02:33.62 03:15.40 21.4%

Figure 6: Median times, in minutes:seconds, for the system responsiveness tests. Lower times are better.
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GRAPHICS PERFORMANCE

You might not play games with complex graphics yourself, but knowing that a
system can handle the most demanding graphics with ease lets you know it will likely
meet your overall performance needs as well. Despite its sleek profile, the new
Ultrabook with its integrated graphics card can deliver outstanding graphics and gaming
experiences. In our tests, it outperformed the 2010 system, which contained an NVIDIA
NVS 3100 discrete graphics card solution.

First, we examined the graphics performance of the two systems using two
benchmarks, UNIGINE Heaven DX 11 and the industry-standard 3DMark Vantage 1.1.0.
On these benchmarks, the Ultrabook prototype outperformed the 2010 laptop by up to
174.0 percent, delivering 2.75 times the graphics performance. Figures 7 through 9
present the graphics performance scores that the systems achieved on the two
benchmarks.
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Figure 7: 3DMark graphics performance benchmark results for the Ultrabook prototype and the 2010 laptop we
tested.
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UNIGINE Heaven DX 11 graphics performance
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Figure 8: UNIGINE Heaven DX 11 graphics performance benchmark results for the Ultrabook prototype and the
2010 laptop we tested.

Graphics performance benchmarks

Ultrabook 2010 Percentage
prototype laptop difference
3DMark Vantage 1.1.0
3DMark Score 3,280 1,197 174.0%
Graphics Score 2,681 933 187.4%
CPU Score 9,933 7,951 24.9%
UNIGINE Heaven DX 11
Score 309 165 87.3%
Average FPS 12.3 6.6 86.4%
Min FPS 8.2 3.9 110.3%
Max FPS 23.4 12.5 87.2%

Figure 9: Median graphics performance benchmark results for the two systems. Higher numbers are better.

To better compare the graphical experience the systems provided, we then ran
a number of common games on the system and used counters (either internal to the
game or external) to determine the average frames per second (FPS) the systems
delivered during gameplay. The more frames per second that a system processes, the
smoother the gaming experience. The Ultrabook improved average FPS over the 2010
laptop on all the games we tested - ranging from 33.0 percent improvement on Diablo
Il performance to a whopping 71.1 percent improvement on Total War Shogun 2. Figure
10 compares the average FPS for common video games on the two systems.
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Graphics performance for common video games
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Figure 10: Graphics performance for common games, in average FPS, for the Ultrabook prototype and the 2010
laptop we tested.

Figure 11 details the average FPS results of the systems running the games we
tested.

Graphics performance — Average FPS of common video games

Ultrabook 2010 Percentage

prototype laptop difference
Diablo Il (Diablo Il Old Tristram using FRAPS - 60 seconds) 43.9 33.0 33.0%
Total War Shogun 2 (Games Settings benchmark) 34.4 20.1 71.1%
Civilization V (Leader Benchmark) 23.35 17.09 36.6%

Figure 11: Average frames per second (FPS) while running each game. Higher numbers are better.

Ultrabook: System responsiveness, performance, and battery life A Principled Technologies test report 8



BENCHMARK PERFORMANCE

It’s important that your laptop be up to the task of handling today’s media, so
that you can organize your music, produce videos, and create photos. To see how the
Ultrabook fared against the 2010 laptop in general performance including media
creation, we ran two industry-standard benchmarks: HDXPRT 2012, which evaluates the
capabilities of PCs in common consumer digital media uses, and PCMark 7, which
evaluates the full range of system performance.

Figure 12 compares the overall HDXPRT Create HD Score for the two systems.
The Ultrabook prototype achieved a 92.6 percent higher score than the 2010 laptop,
indicating it was better able to meet a number of media creation and manipulation

demands.
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Figure 12: HDXPRT 2012 Create HD Scores for the Ultrabook prototype and the 2010 laptop we tested.
Figure 13 details the performance results for the two systems on the HDXPRT
2012 benchmark.

HDXPRT 2012 performance

Ultrabook 2010 Percentage

prototype laptop difference
Create HD Score (higher is better) 208 108 92.6%
Media Organizer - minutes (lower is better) 4.19 6.73 37.7%
Media Creator - minutes (lower is better) 11.60 17.76 34.7%
Photo Blogger - minutes (lower is better) 7.17 10.15 29.4%
Video Producer — minutes (lower is better) 2.10 12.58 83.3%
Music Maker - minutes (lower is better) 2.58 3.24 20.4%

Figure 13: HDXPRT 2012 performance scores for the two systems. A higher overall Create HD Score is better, but lower category
scores are better.
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Figure 14 compares the PCMark 7 performance scores of the two systems. The
Ultrabook prototype achieved higher PCMark7 scores than the 2010 laptop in every
category, for a combined 115.4 percent PCMark 7 score improvement - over twice the

performance.
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Figure 14: PCMark 7 scores for the Ultrabook prototype and the 2010 laptop we tested.

Figure 15 details the performance results for the two systems on the PCMark 7

benchmark.

PCMark 7 performance

Ultrabook 2010 Percentage

prototype laptop difference
PCMark Score 4,295 1,994 115.4%
Lightweight Score 3,548 1,911 85.7%
Productivity Score 2,589 1,504 72.1%
Creativity Score 6,935 2,381 191.3%
Entertainment Score 2,951 1,722 71.4%
Computation Score 6,415 2,618 145.0%
System Storage Score 5,294 1,640 222.8%

Figure 15: PCMark 7 benchmark scores for the two systems. Higher numbers are better.
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BATTERY LIFE

Two of the major attractions of a laptop are maximum portability and flexibility,
so why hold on to a system that tethers you to an electrical outlet? The Ultrabook can
provide long battery life to keep you moving while handling your demanding workloads.

We used the BAPCo® MobileMark® 2012 benchmark to evaluate battery life
during normal use and a 1080p custom video playback test, where the systems ran a
video on loop until the battery expired, to test battery life when watching HD movies.
Figure 16 compares the battery life scores of the systems. The Ultrabook prototype
lasted up to 1 hour 40 minutes longer than the 2010 laptop during the MobileMark 2012
test.
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Figure 16: Battery life times for the Ultrabook prototype and the 2010 laptop we tested.
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Figure 17 presents the battery life performance results for the systems in detail.

Battery life performance
Ultrabook 2010 Percentage
prototype laptop difference
MobileMark 2012
Performance Qualification score 136 118 15.3%
Battery Life score (mm) 290 190 52.6%
Battery Life score (hh:mm) 4:50 3:10 52.6%
1080p Video Playback test
Battery Life score (mm) 243 186 30.6%
Battery Life score (hh:mm) 4:03 3:06 30.6%
Screen brightness (nits) 156 152 NA

Figure 17: Detailed battery life results for the two systems.

WEB BROWSING PERFORMANCE

Today’s Web is an astoundingly interactive environment. Thus, systems with
more power to handle JavaScript and HTML5 make for a better Web browsing
experience.

Figure 18 details the Web browsing performance results for the two systems.
The Ultrabook prototype delivered 66.0 percent more runs per second than the 2010
laptop on the Dromaeo JavaScript benchmark and reduced latency by up to 45.4

percent on SunSpider JavaScript tests.

Web browsing performance
Ultrabook 2010 Percentage
prototype laptop difference
Dromaeo JavaScript (higher is better) 485.13 runs/s 292.16 runs/s 66.0%
SunSpider JavaScript (lower is better) 111.0 ms 203.4 ms 45.4%
GUIMark 2 HTMLS5 (higher is better)
Vector Charting Test - FPS 26 21 23.8%
Bitmap Gaming Test - FPS 60 59 1.7%

Figure 18: Web browsing performance results for the two systems.

ENCRYPTION TIME

While the portability of laptops is an enormous plus, it also opens up the
possibility of loss or theft. Encrypting your hard drive is an effective way to keep your
personal data safe. New technologies have made encryption on the Ultrabook faster
than ever.

We encrypted the hard drives of both systems using BitLocker®, and found that
encrypting the disk on the Ultrabook prototype was 2.5 times faster, or took 60.2
percent less time than encrypting the 2010 laptop. Figure 19 compares the full disk
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encryption times on the systems. Note: For this test, we resized the 2010 laptop’s hard
drive to 180GB in order to match the Ultrabook prototype’s 180GB HDD size.
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Figure 19: Full disk encryption times for the Ultrabook prototype and the 2010 laptop we tested.

Once a hard disk is encrypted, new files that are stored on the hard drive must
also be encrypted to continue protecting all data. We ran another set of responsiveness
tests, this time with encrypted disks, to compare the encryption performance of the
systems as the user experiences it day to day. Again, the Ultrabook prototype
outperformed the 2010 laptop, this time by 54.1 percent when launching a project in
Adobe Photoshop Elements with an encrypted disk. Figure 20 compares the times it
took the systems to complete system responsiveness tasks with encrypted disks.
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Systemresponsiveness with an encrypted disk
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Figure 20: System responsiveness times for tasks with an encrypted disk for the Ultrabook prototype and the 2010
laptop we tested.

Figure 21 presents the results of our full disk encryption and system

responsiveness with encrypted disks tests.

Encryption times

Ultrabook 2010 Percentage
prototype laptop difference
Time to encrypt the HDD (mm:ss) 20:18.00 51:03.00 60.2%
Adobe Photoshop Elements tasks
Project launch time (mm:ss) 00:10.60 00:23.09 54.1%
Convert project to JPEG (mm:ss) 01:34.65 01:47.30 11.8%
Adobe Premiere Elements tasks
Project launch time (mm:ss) 00:10.09 00:12.67 20.4%
Convert project to MPEG-2 (mm:ss) 02:33.77 03:18.03 22.4%

Figure 21: Detailed encryption test results for the two systems.
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THE BENCHMARKS WE USED

In this section, we present a brief overview of the benchmarks we used in our
testing. For detailed system configuration information, see Appendix A. For step-by-step
details on how we tested, see Appendix B.

BAPCo MobileMark 2012

MobileMark 2012 is an industry-standard benchmark that provides a battery life
rating and a performance rating based on common office scenarios. In our tests, we
focus solely on the battery life rating. MobileMark 2012 uses applications and workloads
specific to mobile systems. These include office activities like file and document
management, data processing, and rich content creation. This module provides a score
for battery life of the tested applications.

MobileMark 2012 includes the following applications with their corresponding
tasks:

e ABBYY® FineReader Pro 11

e Adobe Acrobat® Pro X

e Adobe Flash® Player 11

e Adobe Photoshop CS5 Extended 12.04

e Adobe Photoshop Elements 10

e Adobe Premiere Pro CS 5.5

e CyberLink PowerDVD Ultra 11

e Microsoft Excel 2010 SP1

e Microsoft Internet Explorer® 9

e Microsoft Outlook® 2010 SP1

e Microsoft PowerPoint 2010 SP1

e Microsoft Windows Media Player

e Microsoft Word 2010 SP1

e Mozilla® Firefox® 10.0.2

e WinZip® Pro 16

MobileMark 2012 measures system battery life in minutes. It records system
battery life at the start of the benchmark and repeats the workload until the system
battery life is depleted, or until the system powers down due to low battery life.

MobileMark 2012 records a timestamp once per minute. At the end of the
benchmark, it compares the beginning timestamp to the final (last recorded) timestamp.
MobileMark 2012 derives its system battery life rating as the number of minutes
between the start and end timestamps.

For more information on this benchmark, see

http://www.bapco.com/products/mobilemark2012/index.php.
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Futuremark® 3DMark Vantage
Futuremark 3DMark Vantage is a benchmark designed to rate the performance

of DirectX® 10 gaming PCs. It includes two graphics tests, two CPU tests, and six feature
tests. The benchmark reports both graphics and CPU scores, as well as an overall
3DMark score to rate overall gaming performance.

For more information on 3DMark Vantage, see
http://www.3dmark.com/3dmarkvantage/.

Futuremark PCMark 7
Futuremark PCMark 7 is an industry-standard benchmark designed to test the
performance of Windows 7 PCs. It uses over 25 workloads to test storage, computation,
image and video manipulation, Web browsing, and gaming. PCMark 7 reports the
following scores: Lightweight, Productivity, Creativity, Entertainment, Computation, and
System Storage, and uses these scores to create an overall PCMark Score.
For more information on PCMark 7, see
http://www.pcmark.com/benchmarks/index.html.
HDXPRT 2012

The High Definition eXperience & Performance Ratings Test (HDXPRT) 2012, is a
benchmark that evaluates the capabilities of PCs in consumer digital media uses,
including

e Media Organizer
e Media Creator

e Photo Blogger

e Video Producer
e Music Maker

For more information on HDXPRT 2012, see www.hdxprt.com.

UNIGINE Heaven DX 11

Heaven Benchmark is a DirectX 11 GPU benchmark based on advanced
UNIGINE™ engine. According to the UNIGINE Web site, it “reveals the enchanting magic
of floating islands with a tiny village hidden in the cloudy skies. Interactive mode
provides emerging experience of exploring the intricate world of steampunk.”

For more information on UNIGINE Heaven DX 11, see

http://unigine.com/products/heaven/.
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IN CONCLUSION

In our tests, an Ultrabook prototype improved performance dramatically over a
2010 laptop system in every area we tested. The Ultrabook prototype reduced boot
time by 74.7 percent, launched common applications up to 57.6 percent faster,
provided up to 2.75 times the graphics performance, increased battery life by up to 52.6
percent, and encrypted a hard disk 2.5 times faster than the 2010 laptop we tested. It
also provided a responsive touch-screen interface.

The benefits of replacing your older laptop with a new Ultrabook are clear: you
can get more performance and a better experience out of a sleeker, more easily
portable Ultrabook system.
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APPENDIX A — SYSTEM CONFIGURATION INFORMATION

Figure 22 provides detailed configuration information for the test systems.

System Ultrabook prototype 2010 laptop system
General

Number of processor packages 1 1

Number of cores per processor 2 2

Number of threads 4 4

System power management policy Balanced Balanced

Processor power-saving option

Enhanced Intel SpeedStep®
Technology

Enhanced Intel SpeedStep
Technology

System dimensions (length x width x
height)

13" x 8-7/8” x 5/8”

13-1/16” x 9-5/8” x 1-1/4”

System weight 3 Ibs. 2.0 oz. 5 lbs. 2.5 oz.

CPU

Vendor Intel Intel

Name Core™ i7 Core i7

Model number 3667U 620M

Stepping E1 C2

Socket type and number of pins Socket 988B rPGA Socket 989 rPGA

Core frequency (GHz) 2.00 2.66

L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 512 KB (256 KB per core) 512 KB (256 KB per core)
L3 cache 4 MB 4 MB

Platform

Vendor Intel Dell

Motherboard model number Latexo FFRD 0K42JR

Motherboard chipset Intel UM77 Intel QM57

BIOS name and version

American Megatrends ACRVMBY
1.86C.0091.P03.1206261010
(06/26/2012)

Dell A12 (05/09/2012)

Memory module(s)

Vendor and model number

Micron 4KTF25665HZ-1G4D1

Samsung M471B5673FHO-CF8

Type PC3-10700 PC3-8500
Speed (MHz) 1,333 1,066
Speed running in the system (MHz) 1,333 1,066
Timing/Latency (tCL-tRCD-tRP-

tRASMInN) 9-9-9-24 7-7-7-20
Amount of System RAM (GB) 4 4

RAM stick size (MB) 2,048 2,048
Number of memory module(s) 2 2
Channel (single/dual) Dual Dual
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System Ultrabook prototype 2010 laptop system

Hard disk

Vendor and model number Intel SSDSC2BW180A3H Seagate ST9500420AS

Number of disks in system 1 1

Size (GB) 180 500

Buffer size (MB) N/A 16

RPM N/A 7,200

Type SATA 6.0 Gb/s SATA 3.0 Gb/s

Controller Intel 7 Series/C216 Chipset Family Intel 5 Series 6 Port SATA AHCI
SATA AHCI Controller Controller

Driver Intel 9.3.0.1011 (08/26/2011) Intel 9.6.0.1014 (03/03/2010)

Operating system

Microsoft Windows 8 Professional

Name RTM Microsoft Windows 7 Ultimate
Build number 9200 7601

Service Pack N/A 1

File system NTFS NTFS

Kernel ACPI x64-based PC ACPI x64-based PC
Language English English

Microsoft DirectX version DirectX 11 DirectX 11
Graphics

Vendor and model number Intel HD Graphics 4000 NVIDIA® NVS 3100
Type Integrated Discrete

Chipset Intel HD Graphics 4000 NVS 3100

BIOS version 2137.0 70.18.53.0.4

Total available graphics memory (MB) | 1,696 2,266

Dedicated video memory (MB) 64 512

System video memory (MB) 0 0

Shared system memory (MB) 1,632 1,754

Resolution

1,600 x 900 x 32-bit

1,440 x 900 x 32-bit

Driver

Intel 9.17.10.2753 (05/14/2012)

NVIDIA 8.17.12.9679 (05/10/2012)

Sound card/subsystem

Vendor and model number

Realtek® High Definition Audio

IDT High Definition Audio

Realtek Semiconductor Corp

Driver 6.0.1.6612 (04/10/2012) IDT 6.10.0.6292 (07/22/2010)
Ethernet

Vendor and model number N/A Intel 82557LM Gigabit

Driver N/A Intel 11.6.92.0 (12/03/2010)
Wireless

Vendor and model number Intel Centrino® Advanced-N 6235 Intel Centrino Ultimate-N 6300
Driver Intel 15.5.0.30 (03/28/2012) Intel 13.3.0.24 (07/14/2010)

Optical drive(s)

Vendor and model number

N/A

TSSTcorp TS-U633F

Type

N/A

DVD-RW
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System

Ultrabook prototype

2010 laptop system

USB ports

Number 2 4

Type USB 3.0 UsB 2.0

Other Media card reader, HDMI Media card reader, eSATA

IEEE 1394 ports

Number 0 | 1-4pin

Monitor

LCD type LCD eDP with Cando+Atmel WXGA+ Anti-Glare LED Display
touchscreen

Screen size 13.3” 14.1”

Refresh rate 60 Hz 60 Hz

Battery

Type ATL 594793 Lithium-ion W1193 Lithium-ion

Size (length x width x height)

N/A - integrated

8-1/4" x 1-7/8"” x 13/16”

Rated capacity

47Wh

60Wh

Weight

N/A - integrated

11.3 oz.

Figure 22: System configuration information for the test systems.
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APPENDIX B - HOW WE TESTED
MEASURING TIME TO BOOT, HIBERNATE, SLEEP, AND SHUT DOWN

Measuring time to boot and shut down
1. Simultaneously start the timer and boot the system.
2. Stop the timer when the word Start appears.
3. Record the result as the Boot time.
4. Bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
5. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Settings=> Power.
Simultaneously start the timer and click Shut down.
Stop the timer when the power LED turns off.
10 Record the result as the shutdown time.
11. Repeat steps 1 through 10 two more times, and report the median of the three runs.

Measuring time to hibernate/resume from hibernation
1. Boot the system and open an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Settings=>Power.
Simultaneously start the timer and click Hibernation.
Stop the timer when the power LED turns off.
Record the result as the hibernation time.
Simultaneously start the timer and press the power button to resume from hibernation mode.
Stop the timer when the Windows taskbar appears.
10 Record the result as the resume from hibernation time.
11. Shut down the system.
12. Repeat steps 1 through 11 two more times, and report the median of the three runs.

Measuring time to sleep/resume from sleep
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
3. After the command completes, wait 5 minutes before running the test.
4. Open the Charm bar, and click Settings—>Power.
5. Simultaneously start the timer and click Sleep.
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Stop the timer when the power LED starts to blink.

Record the result as the sleep time.

Simultaneously start the timer and press the power button to resume from sleep mode.
Stop the timer when the Windows taskbar appears.

10 Record the result as the Resume from sleep time.

11. Shut down the system.

12. Repeat steps 1 through 11 two more times, and report the median of the three runs.

© oo~

MEASURING TIME TO OPEN APPLICATIONS

Setting up the Microsoft Office tests
1. Install Microsoft Office 2010 with default options.
2. Install Office 2010 Service Pack 1.

Measuring time to open Microsoft Word
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Search.
Type Word
Simultaneously start the timer and click the Microsoft Word button.
Stop the timer when Microsoft Word is fully displayed.
Close Microsoft Word.
Shut down the system.
10 Repeat steps 1 through 9 two more times, and report the median of the three runs.

Measuring the time to open Microsoft Excel
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Search.
Type Excel
Simultaneously start the timer and click the Microsoft Excel button.
Stop the timer when Microsoft Excel is fully displayed.
Close Microsoft Excel.
Shut down the system.
10 Repeat steps 1 through 9 two more times, and report the median of the three runs.
Measuring the time to open Microsoft PowerPoint
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
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c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Search.
Type Power Point
Simultaneously start the timer and click the Microsoft PowerPoint button.
Stop the timer when Microsoft PowerPoint is fully displayed.
Close Microsoft PowerPoint.
Shut down the system.
10 Repeat steps 1 through 9 two more times, and report the median of the three runs.

Measuring the time to open Apple iTunes

Setting up the test
1. Download and install iTunes 10.6.3 with the default options from http://www.apple.com/itunes/download.

©ENOU AW

Running the test
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Search.
Type iTunes
Simultaneously start the timer and click the Apple iTunes button.
Stop the timer when Apple iTunes is fully displayed.
Close Apple iTunes.
Shut down the system.
10 Repeat steps 1 through 9 two more times, and report the median of the three runs.

Measuring the time to open Adobe Photoshop Elements 10

Setting up the test

1. Download and install Photoshop Elements with default options from
http://www.adobe.com/cfusion/tdrc/index.cfm?product=photoshop elements&loc=en us.

2. Copy the test Photoshop Elements test file to the desktop.

©ENOU AW

Running the test
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Simultaneously double-click the Adobe Photoshop Elements test file, and start the stopwatch.
Stop the stopwatch when the file is loaded into Photoshop Elements.
Click File->Save As
Select JPEG from the drop down format menu and enter a file name.

Noukw
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8. Click Save.

9. In JPEG Options, slide the file size bar all the way to the right for the largest file (12).
10. Simultaneously click OK, and start the stopwatch.

11. Stop the stopwatch when the progress bar disappears and the curser stops spinning.
12. Shut down the system.

13. Repeat steps 1 through 12 two more times, and report the median of three runs.

Measuring the time to open Adobe Premiere Elements 10 and encode a file to MPEG

Setting up the test

1. Download and install Premiere Elements with default options from
http://www.adobe.com/cfusion/tdrc/index.cfm?product=premiere _elements&loc=en us

2. Copy the Adobe Premiere Elements test file to the desktop.

Running the test
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Simultaneously double-click the Adobe Premiere Elements test file, and start the stopwatch.
Stop the stopwatch when the project is loaded into Adobe Premiere Elements.
Click the Share tab and select Computer.
Select MPEG, enter a file name, and simultaneously click Save, and start the stopwatch.
Stop the stopwatch when the progress bar disappears and the Done button appears.
Shut down the system.
Repeat steps 1 through 9 two more times, and report the median of three runs.
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MEASURING GRAPHICS PERFORMANCE

Measuring graphics performance with 3DMark Vantage 1.1.0

Installing and patching 3DMark Vantage

1. Download the 3DMark_Vantage_v110_installer.exe Windows package from
http://www.futuremark.com/benchmarks/3dmarkvantage/download/

2. Install 3DMark Vantage 1.1.0 with the default options by double-clicking the 3DMark_Vantage_v110_installer.exe

file.

At the Welcome screen, click Next.

At the License Agreement screen, click | accept the terms of the license agreement, and click Next.

At the Setup Type screen, click Express, and click Next.

At the Ready to Install the Program screen, click Install.

When the 3DMark Vantage Read Me page appears in your Web browser, review the document, and click Close

when you are finished.

At the Setup Complete screen, click Finish.

Launch 3DMark Vantage 1.1.0 by double-clicking on the 3DMark Vantage desktop icon. Enter the registration code,

and click Register.

10. Exit 3DMark Vantage 1.1.0.

Noukw

o

Ultrabook: System responsiveness, performance, and battery life A Principled Technologies test report 24


http://www.adobe.com/cfusion/tdrc/index.cfm?product=premiere_elements&loc=en_us
http://www.futuremark.com/benchmarks/3dmarkvantage/download/

Running 3DMark Vantage 1.1.0
1. Boot the system and bring up a command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Double-click the 3DMark Vantage desktop icon to launch the benchmark.
In the 3DMark Vantage Main section, click the Preset pull-down menu arrow, and select Performance.
Click the Options tab, then click the Graphic Tests tab, and ensure that both tests are selected.
Click the CPU Tests tab, and ensure that both tests are selected.
Click the Graphic Tests tab, and ensure that both tests are selected.
. Click the Feature Tests tab, and deselect all six tests by clicking the check mark by each title.
10. Click Run Benchmark.
11. When the benchmark run completes, take a screenshot of the results, and record them as follows:
a. 3DMark Score
b. GPU Score
c. CPU Score
12. Perform steps 1 through 10 two more times, and report the median of the three runs.

Measuring graphics performance with UNIGINE Heaven DX 11

Installing and patching 3DMark Vantage

Download Heaven DX11 from http://unigine.com/products/heaven/.

Install Heaven DX11 with the default options by double-clicking the Unigine_Heaven-3.0.exe file.
At the Welcome screen, click Next.

At the License Agreement screen, click | accept the license agreement, and click Next.

At the User Information screen, click Next.

At the Select Destination Location screen, click Next.

At the Select Components screen, click Next.

At the Ready to Install screen, click Install.

Click Finish.

Running UNIGINE Heaven DX 11
1. Boot the system and bring up a command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
3. After the command completes, wait 5 minutes before running the test.
Double-click the Heaven DX11 Benchmark 3.0 desktop icon to launch the benchmark.
5. Select the following options:
a. API: DirectX 11
Tessellation: Disabled
Shaders: High
Anisotropy: 4x
Stereo 3D: Disabled
Multi monitor: Unchecked
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1.

2.

g. Anti-aliasing: Off
h. Full screen: Checked
i. Resolution: 1440x900
Click Run.
Click Benchmark.
When the benchmark run completes, save the results, and record them.

Perform steps 1 through 9 two more times, and report the median of the three runs.
Measurlng graphics performance with Diablo Il

Setting up the test
Download the Diablo-lll-SetUp-enUS.exe game client from http://us.battle.net/d3/en/purchase

Double-click the Diablo-1lI-SetUp-enUS.exe file.
Click Install.
After the game has been installed, click Play.
Click Options.
Set the video options to:
i. Full screen
ii. 1280x720p 16:9 widescreen
iii. Max Foreground FPS 150
iv. Max Background FPS 8
v. Texture Quality: High
vi. Shadow Quality: Medium
vii. Physics: High
viii. Clutter Density: Medium
f. Enter account name and password.
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g. Play the enough of the game to get to the ‘Old Tristram” level, and exit the game.

Download FRAPSsetup.exe from http://www.fraps.com/download.php
a. Double-click the FRAPSsetup.exe file.

Launch FRAPS by clicking the desktop icon.
Under the General tab, check the boxes next to:
i. Start Fraps minimized
ii. Fraps window always on top
iii. Run Fraps when Windows starts
h. Under the FPS tab, check the boxes next to:

i. FPS
ii. Frametimes
iii. MinMaxAvg
iv. Stop benchmark after 60 seconds
i. Exit FRAPS.

Running the test

1.

Boot the system and open an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click Run as administrator button.

b. Atthe license agreement, click | agree.

c. Atthe Destination Folder screen, accept the defaults, and click Next.
d. Click Install.

e. Click Finish.

f.

g.
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10

11.
12.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

Launch Diablo 11l by clicking on the desktop icon.

Click Play.

Enter the account name and password.

Click Resume game.

Press F11 to start FRAPS and play 1 minute of the game level.

When 1 minute has passed exit the game.

View the FRAPS files saved in C:\Program Files\FRAPS\Benchmarks and record the results.
Shut down the system.

Repeat steps 1 through 11 two more times, and report the median of the three runs.

Measuring graphics performance with Civilization V
Setting up the test

WO NOURWNE

S N =
W N RO

14.
15.
16.
17.
18.

Insert the Civilization V DVD.

Click Install Sid Meier’s Civilization V.

Accept the license agreement, and click Install.
Accept the Steam license agreement, and click Next.
Click Install.

Enter Log In information, and click Next.

Enter the product code, and click Next.

Click Next.

Click Next.

. Click I Agree.

. Deselect Create start menu shortcut, and click Next.
. Click Finish.

. Create the benchmark shortcuts:

a. Navigate to the Civilization V launch executable: C:\Program Files (x86)\Steam\steamapps\common\Sid
Meier's Civilization V
b. Right-click CivilizationV.exe, and choose Send to—> Desktop (create shortcut)
c. Onthe Desktop, right-click the newly created shortcut, and select Properties.
d. Inthe Target field add the following: -LeaderBenchmark
e. Click Apply.
Navigate to the Civilization V config file: C:\Program Files (x86)\Steam\steamapps\common\Sid Meier's Civilization V
Right-click Config.ini, and select Edit.
Set LoggingEnabled to 1.
Click Save.
Close Config.ini.

Running the test

1.

Boot the system and open an administrative command prompt:

a. Type CMD

b. Right-click the Command Prompt app to open App options.

c. Click Run as administrator button.

TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

Double-click the Civilization V benchmark desktop shortcut to launch the benchmark.
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Select Sid Meier’s Civilization V DirectX 10 & 11 (Recommended).

When the test completes, record the score, and shut down the system.

Repeat steps 1 through 7 two more times, and report the median of the three runs.
Shut down the system.

Repeat steps 1 through 7 two more times, and report the median of the three runs.

Measurlng graphics performance with Total War Shogun 2

Setting up the test
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18.

Insert the Total War Shogun DVD into the disk drive.

Click Run SETUP.EXE

Click OK.

Click Install Total War: SHOGUN 2.

Accept the terms of the license agreement, and click Install.
Accept the terms of the Steam license agreement, and click Next.
Click Install.

Enter Log In information, and click Next.

Enter the product key, and click Next.

. Click Next.

. Click Next.

. Insert Disk 2, and click OK.

. Click Finish.

. Allow Total War: Shogun 2 time to finish autodownloading and patching.
. Select Total War: Shogun 2, and click Play.

. Select Options.

. Set the following graphic options:

Particle Effects: Low

Anti-Aliasing: None

Texture Filtering: Trilinear

Depth of Field: Off

Shader Model: Shader Model 3 (Low)

DirectX Mode: DirectX 9

Unit Detail: Low

Building Detail: Medium

Shadows: Low

Unit Size Large

Maximum Fleet Size: Large

Trees: Medium
. Grass: Medium

Water: Medium

Sky: Low

Terrain Quality: Low

Check Distortion Effects (heat haze)
Click AppIy now.
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Running the test

1.

Boot the system and open an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click Run as administrator button.
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Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

Double-click the Steam desktop icon to launch Steam.

Select the Library Tab.

Select Total War: Shogun 2, and click Play.

Select Benchmark Game Settings, and click Play.

Record the results.

Select Total War: Shogun 2, and click Play.

. Select Benchmark DX9 CPU, and click Play.

. Record the results, and click Ok.

. Shut down the system.

. Repeat steps 1 through 12 two more times, and report the median of the three runs.

MEASURING SYSTEM PERFORMANCE

Measuring system performance with HDXPRT 2012
Setting up the test

1.
2.
3.
4.

Insert the HDXPRT DVD-ROM into your DVD drive.

At the HDXPRT Install screen, click Install HDXPRT.

Accept the HDXPRT end user license agreement.

After the setup is complete, select Yes, | want to restart my computer now, and click Finish.

Running the test

1.

2.
3.
4.

Click the HDXPRT 2012 shortcut on the desktop.

Click Run HDXPRT.

Enter a test name, choose 3 iterations, and click Run.

The Results Screen automatically appears at the end of a successful run. The test results files are found in the
C:\ProgramFiles\HDXPRT\Reports\<TestName> directory.

Measuring system performance with Futuremark PCMark 7
Setting up the test

1.
2.

3.
4.

5.

Reset the system with the appropriate test image.

Download the PCMark_7 v104_installer.exe Windows package from
www.futuremark.com/benchmarks/pcmarkvantage/download/.

Install PCMark 7 1.0.4 with the default options by double-clicking the PCMark_7 v104_installer.exe file.

Launch PCMark 7 1.0.4 by clicking on the PCMark 7 desktop icon. Enter the registration code, click Register, and click
OK.

Exit PCMark 7 1.0.4.

Running the test

vk wnN e

Reboot the system.

Double-click the PCMark 7 desktop icon to launch the benchmark.

Select all test suites.

Click Run Benchmark.

When the benchmark run completes take a screenshot of the results, and record them as follows:
e PCMark Score

e Lightweight Score

o Creativity Score

e Entertainment Score
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e Computation Score
e System Storage Score
6. Repeat steps 1 through 5 two more times, and report the median of the three runs.

MEASURING BATTERY LIFE
Measuring battery life with MobileMark 2012

Avoiding antivirus software conflicts
MobileMark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software

present on the laptop PCs before we installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 2012 installs the following applications, which its test scripts employ:

e ABBYY FineReader Pro 11
e Adobe Acrobat Pro X
e Adobe Flash Player 11
Adobe Photoshop CS5 Extended 12.04
Adobe Photoshop Elements 10
Adobe Premiere Pro CS 5.5
CyberLink PowerDVD Ultra 11
Microsoft Excel 2010 SP1
Microsoft Internet Explorer
Microsoft Outlook 2010 SP1
Microsoft PowerPoint 2010 SP1
e Microsoft Windows Media Player
e  Microsoft Word 2010 SP1
e Mozilla Firefox 10.0.2
e WinZip Pro 16
If any of these applications are already on the system under test, they could cause problems with the

benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all
conflicting pre-installed software applications, including different versions of any of the programs MobileMark 2012

uses.

Adjusting display brightness and power settings
The brightness of a laptop’s display affects its battery life. Therefore, BAPCo requires that, before you test with

MobileMark 2012, you do the following step: make sure the brightness of the laptop’s monitor is greater than or equal
to 150 nits on a completely white screen while the laptop is unplugged and running on battery power. The measurement
follows the standards from the Video Electronics Standards Association (www.vesa.org).

We complied with this standard for all the tests we ran by setting the laptop PC’s brightness as close to 150 nits
as we could without going below that brightness level. We used the following procedure before we started each test.
Note: This procedure assumes we began with the laptop plugged into the power supply.

1. To create a completely blank, white screen, open Microsoft Paint by typing Paint.
2. Press Ctrl+W to open the Resize and Skew dialog.
3. Under Horizontal and Vertical enter 200, and click OK.
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Click the View tab.

Click Full screen to view a white screen.

Wait 45 minutes to allow the screen to warm.
Unplug the laptop from the power supply, and measure the display’s brightness using a luminance meter in the

center of the screen. (We used the Gossen Mavolux5032C.)
8. If the reading is below or significantly greater than 150 nits, adjust the screen brightness to as close to 150 nits,
without going under, as possible. Then retest:
Type Power Options, and click Settings to filter the results. Click Power Options.

a.

b.
C.
d.

Click Change plan settings.
Click Change advanced power settings.

Expand the Display option, and change the Display brightness on battery and plugged in to the correct

percentage that produces no less than 150 nits.

9. Allow the laptop to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or
down as necessary.
10. Verify that the laptop saved the brightness setting by plugging in the system, unplugging it, and taking another
reading.

Using the MobileMark built-in Configuration Tool
This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED in order for the benchmark to run.

2. Additionally, makes changes that are RECOMMENDED for repeatable results.

3. Additionally, makes OPTIONAL changes that help ensure best results.

The Configuration tool makes the following configuration changes at each of the three levels:

Level 1 - Required

Disables User Account Control (UAC)
Disables Windows Update

Disables System Sleep and Hibernate

Sets Screen Dimming Timeout (2 minutes)
Disables Low Battery Actions

Disables Network Proxies

Disables Autorun for Optical Drive

Level 2 - Recommended

Create BAPCo power scheme

Set Power Plan Type to balanced

Disables Windows Firewall

Disables Windows Sidebar/Gadgets
Disables Windows Pop-ups

Disables Incoming Remote Desktop Connections
Disables Windows Error Reporting

Disables Screen Saver and Monitor Timeout
Sets CPU Adaptive Mode

Disables Desktop Slideshow

Disables Disk Defrag

Level 3 - Optional

Sets Hard Disk Timeout
Disables Windows Defender
Disables System Restore
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e Ignores Laptop Lid Close
e Sets Maximum Display Brightness

e Disables Adaptive Brightness
We chose all options listed - Level 3- in the Configuration tool.

Installing MobileMark 2012 and configuring the system for testing
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10.
11.
12.
13.
14.
15.

Verify that the wireless adapter is enabled and connected to a wireless router that is not connected to the Internet.
Insert the MobileMark 2012 Install DVD into the laptop PC’s DVD drive.
When the Autoplay menu appears, click Run MobileMark2012_Setup.exe.
At the Welcome screen, click Next.
Enter the serial number, and click Next.
Accept the license agreement, and click Next.
At the Choose Components screen, select Full, and click Next.
At the Choose Install Location screen, accept the default location of C:\Program Files (x86)\BAPCo\MobileMark2012,
and click Next.
At the Choose Start Menu Folder screen, click Install.
Insert Disc 2 when prompted.
At the InstallShield Wizard Complete screen, click Finish.
Launch MobileMark 2012.
Click Configuration and choose only the Required options.
Click Apply, and restart the computer when prompted.
Adjust the screen brightness to no less than 150 nits:
a. Type power options, then click Settings to filter the results, and click on Power Options.
b. Click Change plan settings.
c. Click Change advanced power settings.
d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct
percentage that produces no less than 150 nits.

Conditioning the battery

1.
2.

E

9.

Plug the AC power adapter into the laptop PC, and completely charge the battery.

Install MobileMark 2012, following the steps we outlined in the Installing MobileMark 2012 section earlier in this
section.

Double-click the MobileMark 2012 icon on the desktop.

Click the Office Productivity icon.

Type System Conditioning asthe name for this test in the Project Name, check the box next to conditioning,
and click Continue.

If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close
MobileMark 2012, and correct the problem(s) before proceeding.

When prompted, unplug the AC power adapter. The Office Productivity test begins immediately.

The test is complete when the laptop PC has fully depleted its battery and is no longer operational when running on
battery power.

Plug the AC power adapter into the laptop PC, and completely charge the battery.

Measuring battery life with MobileMark 2012

1.
2.
3.

We performed the following steps to run the MobileMark 2012 Office Productivity benchmark:

Double-click the MobileMark 2012 icon on the desktop.
Select the Office Productivity test by clicking the Office Productivity icon.
Enter a name for this test in the Project Name field, and click Continue.
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4. If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close
MobileMark 2012, and correct the problem(s) before proceeding.
5. When prompted, unplug the AC power adapter. The test begins immediately.
6. The Office Productivity test is complete when the laptop PC has fully depleted its battery and is no longer
operational when running on battery power.
We executed the MobileMark 2012 Office Productivity test three times on the system and took the median

battery life run as the representative score for that test.

Getting the MobileMark 2012 results
After each MobileMark Productivity 2012 test completed, we plugged the AC power adapter into the laptop PC

and turned on the system. MobileMark 2012 started automatically after the system booted, then analyzed the test
scores and opened the Test Results Viewer with the results from the last test.
To submit these results to BAPCo, we saved the test results by performing the following steps:

Click Save.

Enter a name and select FDR to save the results as an FDR file.

Click Save again, and select PDF to save the results as a PDF file.

Browse to the Documents directory where the result FDR and PDF files were saved.

Measurlng battery life with 1080p video playback from file on hard disk

Setting up the test
1. Copy the Elephant’s Dream 1080p test file to the Videos folder.
2. Set power options:
a. Open the Charm bar, and click Settings.
Click Control Panel.
Click Power Options.
Under the Balanced option, click Change plan settings.
Choose Never from the drop down menus for Dim the display, Turn off the display, and Put the
computer to sleep.
3. Adjust the screen brightness to no less than 150 nits:
a. Type Power Options, click Settings to filter the results, and click Power Options.
b. Click Change plan settings.
c. Click Change advanced power settings.
d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct
percentage that produces no less than 150 nits.

W
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Running the test
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Open the Charm bar, and click Search.
Type Windows Media Player.
Click on the Windows Media Player button.
Click on Videos, and select the Elephant’s Dream 1080p test file.
Click Play and simultaneously unplug the system, and start the stopwatch.

PNV AW
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9. Click the automatic repeat button and expand Windows Media Player to full-screen.
10. Stop the stopwatch when the computer shuts down, and record the time.

11. Fully recharge the battery to 100%.

12. Repeat steps 1 through 11 two more times, and report the median of the three runs.

BROWSING WEB SITES

Dromaeo (JavaScript)
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Click on the Internet Explorer button.
In the address bar, type http://dromaeo.com and press Enter.
Click Run Recommended Tests.
Click Run to start the tests.
After the test finishes, record the results that appear.
Turn off the System.
10 Repeat steps 1 to 9 two more times, and report the median of the three runs.

Sunspider (JavaScript)
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Click on the Internet Explorer button.
In the address bar, type http://www.webkit.org/perf/sunspider/sunspider.html and press Enter.
Click the Start SunSpider 0.9.1 now! link to start the test.
After the test finishes, record the total result that appears.
Turn off the System.
Repeat steps 1 to 8 two more times, and report the median of the three runs.

GUIMark 2 (HTMLS5)
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Click on the Internet Explorer button.
In the address bar, type http://www.craftymind.com/guimark2/ and press Enter.
Scroll down to find the Vector Charting Test, and click the HTMLS5 link.
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Click Start Test.
After the test finishes, record the result that appears.
Restart the system.
10. Bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
11. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
12. Do not interact with the system until the command completes.
13. After the command completes, wait 5 minutes before running the test.
14. Click the Internet Explorer button.
15. In the address type http://www.craftymind.com/guimark2/ and press Enter.
16. Scroll down to find the Bitmap Gaming Test, and click the HTMLS5 link.
17. Click Start Test.
18. After the test finishes, record the result that appears
19. Shut down the system.
20. Repeat steps 1 through 19 two more times, and report the median of the three runs.

0o N

ENCRYPTING DATA WITH BITLOCKER
BitLocker Drive Encryption

Setting up the test
1. Verify that TPM is enabled and activated in the BIOS.

Running the test
1. Go to the Control Panel and click BitLocker Drive Encryption.
2. Verify that the C: drive is selected and click Turn On BitLocker.
3. At the BitLocker Drive Encryption checklist setup screen, click Next.
4. At the preparing your drive for BitLocker screen, click Next. When the drive has been prepared a green
checkmark will appear next to Prepare your drive for BitLocker.
Click Next.
6. Atthe How do you want to store your recovery key screen, select Save the recovery key to a USB flash drive,
and click Save.
7. Click Next.
8. Simultaneously start the timer and click Start Encrypting.
9. Stop the timer when the encrypting progress bar has disappeared and the drive is encrypted.
10. Decrypt the drive and perform steps 1 through 9 two more times, and report the median of the three runs.

BitLocker Photoshop Elements

Setting up the test

1. Verify that TPM is enabled and activated in the BIOS and that the drive has been encrypted by the previous test.

2. Download and install Photoshop Elements with default options from
http://www.adobe.com/cfusion/tdrc/index.cfm?product=photoshop elements&loc=en us.

3. Copy the test Photoshop Elements test file to the desktop.

b

Running the test

1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
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2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

3. After the command completes, wait 5 minutes before running the test.

4. Simultaneously double-click the Adobe Photoshop Elements test file, and start the stopwatch.

5. Stop the stopwatch when the file is loaded into Photoshop Elements.

6. Click File->Save As

7. Select JPEG from the drop down format menu and enter a file name.

8. Click Save.

9. InJPEG Options, slide the file size bar all the way to the right for the largest file.

10. Simultaneously click OK, and start the stopwatch.

11. Stop the stopwatch when the progress bar disappears and the curser stops spinning.

12. Shut down the system.

13. Repeat steps 1 through 12 two more times, and report the median of three runs.

BitLocker Premiere Elements

Setting up the test

1. Verify that TPM is enabled and activated in the BIOS and that the drive has been encrypted by the previous test.

2. Download and install Premiere Elements with default options from
http://www.adobe.com/cfusion/tdrc/index.cfm?product=premiere elements&loc=en us

3. Copy the Adobe Premiere Elements test file to the desktop.

Running the test
1. Boot the system and bring up an administrative command prompt:
a. Type CMD
b. Right-click the Command Prompt app to open App options.
c. Click the Run as administrator button.
2. TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
Simultaneously double-click the Adobe Premiere Elements test file, and start the stopwatch.
Stop the stopwatch when the project is loaded into Adobe Premiere Elements.
Click the Share tab and select Computer.
Select MPEG, enter a file name, and simultaneously click Save, and start the stopwatch.
Stop the stopwatch when the progress bar disappears and the Done button appears.
. Shut down the system.
10. Repeat steps 1 through 9 two more times, and report the median of three runs.
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Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
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